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Abstract 
 

The capabilities of the newest AF-GEOSpace space environment software program are 
reviewed. Released in 2002, AF-GEOSpace Version 2.0 is a graphics-intensive software 
program with space environment models and applications developed and distributed by the 
Space Weather Center of Excellence at the Air Force Research Laboratory (AFRL). A wide 
range of physical domains is addressed including solar disturbance propagation, radiation belt 
configuration, and ionospheric auroral particle precipitation and scintillation. The software is 
currently being used to aid with the design, operation, and simulation of a wide variety of 
communications, navigation, and surveillance systems. Building on the success of previous 
releases, AF-GEOSpace has become a platform for the rapid prototyping of automated 
operational and simulation space weather visualization products and helps with a variety of tasks, 
including: orbit specification for radiation hazard avoidance; satellite design assessment and 
post-event anomaly analysis; solar disturbance effects forecasting; frequency and antenna 
management for radar and HF communications; determination of link outage regions for active 
ionospheric conditions; scientific model validation and comparison, physics research, and 
education. Version 2.0 provides a simplified graphical user interface, improved science and 
application modules, and significantly enhanced graphical performance. Common input data 
archive sets, application modules, and 1-D, 2-D, and 3-D visualization tools are provided to all 
models while FTP scripts are provided to automatically update common daily global input 
parameters. Dynamic capabilities permit multiple environments to be generated at user-specified 
time intervals while animation tools enable, for example, the display of satellite orbits and 
environment data together as a function of time. Documentation examples include detailed 
instructions for investigating phenomena that have well known effects on communications and 
spacecraft systems. To obtain a copy of AF-GEOSpace Version 2.0 for Windows NT/2000/XP, 
please contact the first author. 

mailto:Robert.Hilmer@Hanscom.af.mil


F

 

o
m
e
p
s
R
e
s

 
igure 1.  AF-GEOSpace Version 2.0 for Windows NT/2000/XP was developed by the 

Space Weather Center of Excellence at the Air Force Research Laboratory. With the 
Sun to the left, (yellow) geomagnetic field lines originating from constant magnetic 
latitude envelop the radiation belts and are stretched anti-sunward (to the right). 
Originating at higher latitude, the magnetic field lines of the northern dayside magnetic 
cusp (red) help to define the shape of the dayside magnetopause. Ionospheric electron 
densities are shown with peak bands at latitudes both above and below the Earth's 
geomagnetic equator. 

Introduction 
 
Space systems experience environmental effects ranging from intermittent communication 

utages caused by ionospheric scintillation to total satellite system failures caused by energetic 
agnetospheric particles. Motivated by the need to mitigate the impact of these hazards, space 

nvironment models are employed during the spacecraft design process and operations and 
rovide environmental simulations for a wide variety of communication, navigation, and 
urveillance systems operating at altitudes between 100 km and geosynchronous orbit (6.6 Earth 
adii). While our understanding of fundamental physical processes is still limited, useful 
mpirical, statistical, and theoretical models have been developed to address topics ranging from 
olar coronal mass ejections to the Earth's trapped radiation belts to auroral particle precipitation.  

 



AFRL is constantly expanding its space environment modeling capabilities and has 
integrated a collection of scientific codes and related applications into the AF-GEOSpace 
software program. A sample of the program's output is shown in Figure 1. The program has 
grown and evolved steadily in an effort to address the concerns of the space weather community. 
While some models may not be considered state-of-the-art, they are included to provide valuable 
historical validation baselines and the ability to easily relate output from models covering similar 
domains, e.g., to directly compare results from the CRRES and AE-8 electron radiation belt 
models. The flexibility to simultaneously view science model results and real-time data with a 
common set of visualization tools has allowed AF-GEOSpace to serve AFRL as a development 
platform for some of the automated visualization products required of the operational 
community. With all models running on a common platform, AF-GEOSpace becomes a vehicle 
for rapid model prototyping, model validation, environment specification for spacecraft design, 
mission planning, and anomaly resolution. In short, AF-GEOSpace becomes the backbone for an 
integrated space environment model.  
 

This paper describes the software program AF-GEOSpace Version 2.0 released in 2002. We 
begin by highlighting the program's development history then provide a summary of current 
capabilities by reviewing the Windows pull-down menu functions, and the content of the 
science, application, data, and graphics modules. A complete reference list detailing model and 
application sources is provided. 

 
Development Overview 

 
The first public release of AF-GEOSpace (Version 1.21, 1996/IRIX on SGI) contained 

radiation belt particle flux and dose models derived from CRRES satellite data, an aurora model, 
an ionospheric model, and ionospheric HF ray tracing capabilities. The next public release 
(Version 1.4, 1999/IRIX on SGI)1 added science modules related to the cosmic ray and solar 
proton environment, low-Earth orbit radiation dosages, single event effects probability maps, and 
ionospheric scintillation, solar proton, and shock propagation models. New application modules 
for estimating linear energy transfer (LET) and single event upset (SEU) rates in solid-state 
devices, and modules for visualizing radar fans, communication domes, and satellite detector 
cones and links were added. Automated FTP scripts permitted users to automatically update their 
global input parameter data set directly from NOAA/SEC (Space Environment Center). Real-
time DMSP data modules for displaying auroral particle data and identifying enhanced outer 
zone electron belt populations remain exclusive to Version 1.4.  
 

What’s New? AF-GEOSpace Version 2.0 (for WindowsNT/2000/XP) includes the first true 
dynamic run capabilities and offers new and enhanced graphical and data visualization tools such 
as 3-D volume rendering and eclipse umbra and penumbra determination. The dynamic run 
capability enables the animation of all model results, in all dimensions, as a function of time. 
Version 2.0 also contains a new realistic day-to-day ionospheric scintillation simulation 
generator (IONSCINT), an upgrade to the WBMOD scintillation code, a simplified HF 
ionospheric ray tracing module, and applications built on the NASA AE-8 and AP-8 radiation 
belt models. User-generated satellite data sets can now be visualized along with their orbital 
ephemerides. A tool for visualizing MHD model results stored in structured grids provides a hint 
of where future space weather model development efforts are headed. A new graphical user 



interface with improved module tracking and renaming features greatly simplifies software 
operation. Finally, a major restructuring of the code to an open architecture has greatly increased 
the code’s portability and made it easier in integrate new modules. 
 

AF-GEOSpace Version 2.0 is written in C++ for Windows NT, 2000, and XP. It is rigorously 
object oriented and contains separate user interface, kernel, and graphics libraries. Environment 
modules provide interfaces to the science models and related applications needed to investigate 
the solar, interplanetary, magnetospheric, auroral, and ionospheric environments and their effects 
on communications and spacecraft systems.  
 

The software is divided into five explicit module classes to simplify the integration of new 
algorithms and increase portability. Science Modules control individual science models and 
produce output data sets on user-specified grids. Application Modules typically manipulate these 
data sets, e.g., by integrating dose calculated by a radiation belt model or tracing HF rays through 
a model ionosphere. They also provide capabilities like orbit generation and magnetic field line 
tracing. Data Modules read and assist with the analysis of user-generated data sets. Graphics 
Modules control the one, two, and three-dimensional viewport windows and enable display 
features such as isocontours, plane slices, magnetic field lines, line plots, axes, the Earth, stars, 
and satellites. Worksheet Modules provide transformations between the GEOC, GSM, SM, and 
GEI systems in spherical, cylindrical, and Cartesian coordinates and also provide calendar 
system conversion tools. This separation of modules by function permits the use of common 
inputs and visualization tools by all modules. Next we look at the new dynamic run capability. 

 
Dynamic Run Environments 

 
AF-GEOSpace Version 2.0 supports two basic environment module types: static and 

dynamic. Note that previous releases of AF-GEOSpace supported only static environments. 
Science or application module runs are called static if they produce output representing a single 
Universal Time. All environment models and applications are run using a fixed set of 
geophysical parameters, e.g., the geomagnetic activity index Kp. With the exception of the new 
ionospheric scintillation module and the satellite orbit generator and its associated applications, 
all environment models and applications are run for a fixed Universal Time. Runs are called 
dynamic if they produce output at more than one Universal Time. This dynamic run capability 
allows the user to animate results in all dimensions, e.g., simultaneously view a satellite’s path 
through a generated data set in 3-D, view a 2-D projection on Earth of data slaved to a satellite’s 
altitude, and view a 1-D plot of the time history of data values encountered by the satellite. 
Figure 2 shows 3-D and 2-D graphic frames for a single time from a dynamic run sequence 
representing a 2001 geomagnetic storm. A common set of global parameters was the key to 
generating this coordinated set of environments over the storm time interval. 

 
Global Parameters 

 
The purpose of the global parameter concept is to provide consistent inputs to the multiple 

models that can be created within a single static or dynamic environment. Global parameters are 
the date, time, and geophysical indices shared between many of the models, i.e., the geomagnetic 
activity index Kp, daily sunspot number (SSN), solar radio flux at 10.7 cm (F10.7), planetary 



magnetic index Ap, geomagnetic activity index Dst, and the equatorward boundary of the diffuse 
aurora at midnight (AB). Most models have additional parameter inputs that are entered by the 
user when initializing a module. The last two parameters are included for reference purposes, 
i.e., Dst is useful when constructing magnetic field models and the AB values are useful as 
manual inputs to the aurora science module equatorward edge-mapping algorithm. A data 
archive covering 1932 to 2001 includes the indices Kp and Dst as well as DMSP-derived auroral 
boundaries. These data enable the user to run models over a wide variety of activity levels and 
space weather events. FTP scripts enable automated updates of some common parameters. 

 

 

Figure 2. AF-GEOSpace 2.0 environment models representing 30 March 2001 at 1400 UT.  
Lower: Earth map with precipitating auroral electron flux at high latitudes, total 
electron content (TEC) in the ionosphere with peak over East Africa, and S4 
scintillation index (inset) north of Australia. Upper: Earth with Sun axis to left, inner 



proton belt (9.7 MeV), outer electron belt (1.6 MeV), and magnetic field lines in the 
noon-midnight meridians. Auroral and TEC from lower frame are also visible.  

 
Menus 

 
The functions of the AF-GEOSpace pull-down menus illustrate the software's capabilities.  

 
The File menu provides options to load Environment Window inputs and run results of 

previously saved science and application modules. Module settings and output are saved as 
single Common Data Format (CDF) files. The contents of the active windows can be captured in 
Tagged Image File Format (TIFF) or Joint Photographic Experts Group (JPEG) format.  
 

The Edit menu provides access to features enabling the user to run models, delete models, 
rename entries in the active modules lists, examine text representations of module produced data, 
setup computation grids, set dynamic run mode time step values and output parameter selection, 
and animate results from dynamic module runs (including satellite orbits in static mode).  
 

The Module menu provides access to the five basic module classes: (1) Science Modules 
control individual science models and produce output data sets on user-specified grids, (2) 
Application Modules typically manipulate these data sets, e.g., by integrating dose calculated by 
a radiation belt model or tracing HF rays through a model ionosphere. Application modules also 
provide orbit generation and magnetic field line tracing capabilities, (3) Data Modules read and 
assist with the analysis of user-generated data sets, (4) Graphics Modules control the one, two, 
and three-dimensional windows and enable display features such as plane slices, magnetic field 
lines, line plots, axes, the Earth, stars, and satellites, and (5) Worksheet Modules provide 
commonly requested coordinate transformations and a calendar system conversion tools.  
 

The Windows menu provides access to functions for creating, adjusting, and arranging 
graphics windows, i.e., create 1D, 2D, 3D or special 3-D Heliospace viewports, set background 
color, switch to full screen, or arrange windows in cascading or tile patterns. 
 

The Viewport menu contains options for splitting the active viewport horizontally or 
vertically, transforming a viewport’s dimensionality from 2D to 3D while retaining the displayed 
data, and fixing the viewer's position relative to a selected coordinate system.  

 
In dynamic mode, the Globals menu provides read, write, and save access to the global 

parameters appropriate to the selected time period. A Globals popup window will appear 
showing the parameters Date, Time, Kp, Ap, SSN, F10.7, Dst, and AB. These values can be 
edited and line entries can be added or deleted directly in the text window. All science and 
application modules run will utilize using this same set of global input values. In static mode the 
global parameters used to represent the single selected time are contained in the Kp, SSN, F10.7, 
and Ap text boxes at the top of the Environment window. 

 
The Help menu connects the user to a PDF version of the user’s manual. The manual 

includes an extensive examples section with click-by-click instructions allowing the user to 
recreate the graphics presented. 



 
 
 

Science Modules 
 

Science modules provide methods for generating data sets from various space environment 
models. The following science modules are supported by AF-GEOSpace: 
 
APEXRAD:  The Advanced Photovoltaic and Electronics Experiment (APEX) space radiation 
dose model2 specifies the location and intensity of the radiation dose rate behind four different 
thicknesses of aluminum shielding for five geomagnetic activity levels as specified by Ap15. It 
covers the Low Earth Orbit (LEO) altitude region (360-2400 km) and was developed to 
supplement the CRRESRAD model (see below) which has limited resolution in the LEO regime. 
 
AURORA:  Auroral precipitation models3, 4 specify the location and intensity of electron number 
and energy flux, ion number and energy flux, Pederson and Hall conductivities, and the 
equatorward boundary at 110 km altitude. This module also provides the capability to map flux, 
conductivity, and equatorial boundary values up magnetic field lines into the three-dimensional 
magnetospheric grid. 
 
CHIME:  The CRRES/SPACERAD Heavy Ion Model of the Environment5 (CHIME) specifies 
the location and intensity of galactic cosmic rays and/or solar energetic particle fluxes and/or 
anomalous cosmic ray fluxes.  
 
CRRESELE:  The Combined Radiation and Release Effects Satellite (CRRES) electron flux 
model6 specifies the location and intensity of electron omni-directional flux over the energy 
range 0.5-6.6 MeV for a range of geomagnetic activity levels.  
 
CRRESPRO:  The Combined Radiation and Release Effects Satellite (CRRES) proton flux 
model7 specifies the location and intensity of proton omni-directional flux over the energy range 
1-100 MeV for quiet, average, or active geophysical conditions.  
 
CRRESRAD:  The Combined Radiation and Release Effects Satellite (CRRES) space radiation 
dose model8 specifies the location and intensity of the radiation dose rate behind four different 
thicknesses of aluminum shielding for active or quiet geophysical activity levels. 
 
IONSCINT:  The High Fidelity Ionospheric Scintillation Simulation Algorithm (IONSCINT) 
model9 provides realistic scenarios of disruptions in trans-ionospheric radio wave 
communications with spacecraft due to equatorial scintillation. IONSCINT addresses only 
intensity (or amplitude) scintillation of 244 MHz signals from geosynchronous satellites and 
represents statistically realistic climatology as well as the day-to-day variability of equatorial 
scintillations. 
 
ISPM:  The Interplanetary Shock Propagation Model10 predicts the transit time of interplanetary 
shocks from the sun to the Earth and the shock strength upon arrival. 
 



NASAELE:  The NASA AE-8 radiation belt model11 is used to compute the intensity and 
location of differential omni-directional electron flux for ten energy intervals between 0.5 and 
6.6 MeV that correspond to the ranges of the CRRES HEEF instrument. 
NASAPRO:  The NASA AP-8 radiation belt model11 is used to compute the intensity and 
location of differential omni-directional proton flux for 22 energy intervals between 1 and 100 
MeV, which correspond to the ranges of the CRRES PROTEL instrument. 
 
PIM:  The Parameterized Ionospheric Model12 (PIM) is a global ionosphere model that generates 
electron number density as well as maps of total electron content (TEC), Height of E and F2 
peaks, and plasma frequencies at the E and F2 peaks as a function of a variety of geophysical 
activity indices. 
 
PPS:  The Proton Prediction System13 (PPS) provides forecasts of the intensity and duration of 
solar proton events. 
 
SEEMAPS:  Single Event Effects Maps14 (SEEMAPS) uses normalized flux and dose data for 
protons with energy > 50 MeV from the APEX and CRRES satellites to produce contour maps 
of relative probabilities of experiencing SEE in the Earth’s inner radiation belts.  
 
STOA:  The Shock Time-of-Arrival Model15 (STOA) predicts the transit time of interplanetary 
shocks from the sun to the Earth. STOA is a predecessor of ISPM. 
 
WBMOD:  The WideBand Model16 (WBMOD) is an RF ionospheric scintillation model 
specifying S4, SI, and other scintillation parameters between any location on the globe and a 
satellite above 100 km altitude at any frequency above 100 MHz as a function of a variety of 
geophysical activity indices. A year 2000 update improves high latitude output. 

 
Application Modules 

 
Application modules provide orbit creation/prediction, dataset integration along orbits, 

magnetic field model generation, and access to specialized ionospheric ray-tracing, graphics, and 
scintillation products. The following applications are supported by AF-GEOSpace: 
 
APEXRAD-APP:  Advanced Photovoltaic and Electronics Experiments (APEX) radiation dose 
model2 calculates expected accumulated yearly dose (in units of rads silicon/year) for four 
thicknesses of aluminum shielding during four levels of magnetic activity. For orbits with 
apogees greater than 2500 km, use CRRESRAD-APP described below. 
 
BFIELD-APP:  The B-Field application allows the generation of datasets representing the 
magnetic field in the near-Earth space environment. A variety of internal (dipole, IGRF) and 
external magnetic field models17, 18, 19, 20 are used to generate gridded data set, and trace field 
lines and flux tubes. 
 
CRRESELE-APP:  The Combined Radiation and Release Effects Satellite (CRRES) electron 
flux model6 is used to estimate of electron fluence, over the energy range 0.5-6.6 MeV, received 
along a user-specified satellite orbit under a wide range of magnetospheric conditions. 



 
CRRESPRO-APP:  The Combined Radiation and Release Effects Satellite (CRRES) proton flux 
model7 is used to calculate proton omni-directional fluence (integral and differential) over the 
range 1 to 100 MeV for user specified orbits and quiet, active, or average geophysical activity 
levels.  
 
CRRESRAD-APP:  Combined Radiation and Release Effects Satellite (CRRES) space radiation 
dose model8 is used to calculate the expected satellite dose accumulation behind four different 
thicknesses of aluminum shielding for user-specified orbits for active or quiet geophysical 
activity levels. 
 
LET-APP:  Calculates the linear energy transfer (LET) spectrum and its associated single event 
upset (SEU) rate in a microelectronic device resulting from the penetration of energetic space 
particles. Effects from both cosmic rays and the trapped protons are estimated by using the 
CHIME5 and CRRESPRO7 models. 
 
NASAELE-APP:  Calculates electron omni-directional fluence (differential and integral) for ten 
energy intervals in the range 0.65-5.75 MeV. A user-specified orbit is traced through the NASA 
AE-8 trapped electron model11 to provide an estimate of electron fluence received by the satellite 
under a wide range of magnetospheric conditions. 
 
NASAPRO-APP:  Calculates proton omni-directional fluence (differential and integral) over the 
energy range 1.5-81.3 MeV for user specified orbits and quiet or active geophysical conditions 
using the NASA AP-8 trapped proton model11.  
 
RAYTRACE-APP:  Calculates the behavior of MHz rays in an ionosphere specified by a 
Parameterized Ionosphere Model (PIM) data set generated using the PIM module. 
 
SATEL-APP:  Calculates orbital trajectories for satellites from a variety of user specified orbital 
element input sets. 
 
WBPROD-APP:  Gives a 24hr WBMOD16 climatology prediction of the dB fade levels due to 
ionospheric scintillation effects for specific ground-to-satellite communication links. 

 
Data Modules 

 
Data modules provide methods for reading and displaying externally generated data sets. The 

following data modules are supported by AF-GEOSpace: 
 
EPHEMERIS:  Allows user-generated time-ordered data and satellite ephemeris to be loaded 
into AF-GEOSpace. Data and satellite trajectory can then be displayed using the ORBIT-PROBE 
(1D) and SATELLITE (3D) graphical modules, respectively. This feature enables data/model 
comparisons as the user-provided satellite trajectory can be used to sample other AF-GEOSpace 
environment models.  
 



PARAMESH:  Allows the user to load MHD simulation run results produced externally using 
the large-scale parallel grid meshing package called Paramesh and MHD science codes 
developed by the Navel Research Laboratory. Loaded data is then displayed within the special 
Heliospace viewport using the Paramesh related graphics modules described below. Details 
about the Paramesh package can be found at the NRL website 
(http://www.lcp.nrl.navy.mil/hpcc-ess/amrmhd3d.10.html). This module was a product of a 
CHSSI collaboration between NRL and AFRL. (Note that this module is actually accessed with 
the File menu option Open Paramesh.)  

 
Graphics Modules 

 
Graphics modules are used to visualize the data sets created through the Application, Data, 

and Science modules. The following graphics are supported by AF-GEOSpace: 
 
ANNOTATION:  Create and display descriptive text or time labels for viewports. 
 
AXES:  Plot a set of axes or sun vector. 
 
COORD-PROBE:  Provides a method for probing data along lines defined in user-specified 
coordinate systems.  
 
COORD-SLICE:  Slice the data set along a constant coordinate surface. 
 
DETECTOR:  Define and associate fixed or tracking detector cones with satellites or station 
locations. 
 
EARTH:  Plot an outlined or solid Earth. A variety of additional features are available including 
geographic, magnetic, and corrected geomagnetic latitude-longitude grids. 
 
EMITTER:  Define and associate fixed or tracking emitters, e.g., radar fan structures, with 
satellites or stations. 
 
FIELD-LINES:  Plot magnetic field lines and surfaces, flux tubes, and location of the auroral 
equatorward boundaries. 
 
GLOBAL INPUTS:  Produce a line plot of the global input data values, e.g., Kp or Dst, as a 
function of time.  
 
GRID:  Plot the 3-D grid associated with a data set.  
 
ISOCONTOUR:  Calculate an isocontour of a data set and plot the resulting surface. 
 
LINK:  View a line-of-sight link between stations and satellites or between satellites.  
 
ORBIT-PROBE:  Plot data sets from along satellite orbits. 
 



ORBIT-SLICE:  Cut the data set with a plane placed at the orbital plane of a satellite (or a plane 
perpendicular to or containing the satellite velocity vector) and plot the resulting slice.  
 
PLANE-SLICE:  Cut the data set with an arbitrary plane and plot the resulting slice. 
 
RAY TRACE:  Produce a depiction of the ionospheric rays traced through the PIM science 
model data sets. 
 
SATELLITE:  Provides a means of viewing satellite trajectories. 
 
STARS:  Plot the celestial background including stars, planets, and the moon. 
 
STATION:  Plot a labeled location on or above the surface of the Earth. 
 
VOLUME:  View the entire volume of a data set as a single three-dimensional object. 
 
PARAMESH-COORDSLICE:  Produce a slice or constant coordinate surface through a data set 
written using the Paramesh parallel meshing software. 
 
PARAMESH-FIELDLINES:  Produce field lines through a Paramesh data set. 
 
PARAMESH-GRID:  Display the grid, block structure (e.g., leaf and parent block), and overall 
domain of a Paramesh data set.  
 
PARAMESH-ISOCONTOUR:  Produce a surface of constant value through a Paramesh data 
set. 
 
PARAMESH-VOLUME:  View the entire volume of a Paramesh data set as a single three-
dimensional object. 

 
Graphical Module Options 

 
Graphical option controls appear in the environment window of each active graphics module. 

The Display option is used to place or display a graphics object in an active viewport. The Use 
Texture mapping option improves the appearance of color data contours. An Interactive option 
controls whether or not graphical renderings are updated immediately as changes are made to the 
graphic inputs. The appearance of a graphical object can be manipulated using the Clipping 
(multiple planes with rotation and translation), Transparency, Lighting (e.g., ambient, specular), 
Material (e.g., emission and shininess), and Color (Red-Green-Blue and Hue-Saturation-Value 
slider) options. The Color Map option enables tailored modifications to the mapping of colors 
assigned to data values represented in the viewport color bar. The Data Map option controls the 
range and linear/log scale used to display data, e.g., to examine a subset of the data range. 
 



 
 
 

Worksheet Modules 
 
Worksheet modules provide auxiliary tools that are helpful in AF-GEOSpace calculations. 

The following worksheet modules are supported by AF-GEOSpace: 
 
CALENDAR:  A calendar showing month and day, day of year, and modified Julian day. 
COORD_TRANSFORM:  Perform coordinate transformations on point locations using different 
coordinate systems (GEOC, GSM, SM, GEI) and coordinate geometries (Cartesian, Cylindrical, 
Spherical) at a given Year, Day, and UT. 

 
Final Comments 

 
The AF-GEOSpace software suite provides the scientific community with a number of 

empirical, statistical, and physics-based models that address concerns about environmental 
hazards affecting real-world space systems. Recent improvements to the software have greatly 
increased its utility and portability. The authors encourage the community to make suggestions 
regarding the addition of new models and applications. AF-GEOSpace Version 2.0 software is 
distributed exclusively by AFRL and can be obtained by contacting the first author. 
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